Turn a Sketch into a Photorealistic Image
Summary

Learn how to turn a rough sketch into an image approximating photo realism. This tutorial mainly details
use of the polygonal lasso tool, the warp tool, some basic filters, the burn and dodge tool, the eraser tool and
some copying and pasting. All source images are provided.

Suitable for a Photoshop beginner

Time For Project: 2-3 hours
Saving your image after each step is advised.

Tools

Photoshop CS5
Graphics tablet (preferred)
Images provided (free for non commercial use) under a creative commons licence.
Commands provided for a computer running Microsoft Windows.

Resources

D270.jpg
img_3805.jpg
img_4305.jpg
img_4308.jpg
picture 041.jpg
picture 315.jpg
img_3815.jpg
Aug09Cairns143.jpg
photomanipulation_tutorial.pdf
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STEP 1: Create New File
Open Photoshop
CNTL + N
name as - photomanip
height - 3000px
width - 3000px
RGB, 300dpi
background: transparent

STEP 2: Adding Source Image to Main Image

Open D270.jpg then CNTL + C and CNTL + V it into the main image.
Position D270 off to the side and click on the tick in the upper RHS of
the screen to accept your action. Name the newly inserted layer “D270”

STEP 3 - Adding Base Colours

SHIFT + CNTL + N or click on the new layer icon to add a new layer
Name this layer “base colours”
Press Z or click on the magnifying glass on the quick access panel and
zoom into the eye area. Use the polygonal lasso tool to roughly select
the eyes.
Chose a large solid brush and a yellowish and using an opacity of 64%,
paint over the selected area once without unclicking your mouse or pen
Repeat this process on the forehead and neck elements (this time using
grey).
Insert a new layer between “base colours” and “D270” name it “skin
base”
Zoom out to see entire image.
Using a large solid brush, colour the head in using a greenish colour and
opacity set to 64%. Don’t worry about being super accurate.

yeatmandesign.com.au

STEP 4 - Adding Shadows

Insert a new layer on top of the existing layers and name it "shadow".
Using a large soft edged brush, and a dark green colour, trace over the
shadows in the base image at 100% opacity.

STEP 5 - Adding Highlights

Insert a new layer on top of the existing layers and name it “highlights”.
Using a large soft edged brush, and a muddy pink colour, trace over the
shadows in the base image at 100% opacity.
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STEP 6 - Adding Eyes

Open img_3805 and cut out the eye and surrounding orbit using the
polygonal lasso tool.
CNTL + C, return to main image and CNTL + V to paste the eye into the
main image.
Lower opacity of newly inserted layer and adjust the eye to match the
under drawing using the warp tool: Edit > Transform > Warp.
CNTL + C and CNTL + V this layer to create a copy of the eye then flip
the new layer horizontally. Position this new eye over the remaining eye
of the base image while the layer opacity is reduced, warp as required.
Return the opacity of the eye layers to 100% and merge these layers down.
Name the merged layer “Eyes”
Use the erase tool to remove any excess inserted image.
Place this layer under the layer named “shadow”.

STEP 7 - Adding Nostril Elements

Open img_4305 and cut out the circular grill (the circular selection tool works well here)
After copying into the main image, resize the grill to fit into the
underdrawing: Edit > Transform > Scale.
Using the warp tool fit the grill into the chosen nostril.
Copy this element and place over the top of the remaining nostril,
warping as required. Merge these two layers and name “nostrils”.
Place this layer under the layer named “shadow”.
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STEP 8- Adding Mechanical Elements

Open img_4308 and using then pen tool, but cut the hose.
save this path potential later use (this had already been
done for you).
Make selection, CNTL + C from img_4308 and CNTL + V
into the main image.
Using the resize, rotate and warp tools, position the hose
onto the LHS neck of the underdrawing.
Paste the hose element again, rotate and resize to
approximate one of the forehead elements then make
several copies of this resized element.

STEP 9 - Adding Mechanical Forehead Elements.

Using three of the hose copies, rotate and warp them so they fit
into the underdrawing.
CNTL + C and CNTL + V this element into a new layer, flip the
element horizontally and name layer as “mech rhs elements”
A quick horizontal flip of the entire image shows it is a tad
lopsided. This will be addressed at a later stage.
Make the copied element fit as best as possible. Do not worry
about the overlap onto the ear at this stage.
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STEP 10 - Adding Mechanical Ear

Open picture 041.jpg and cut out an element or two which can be made into the ear.
CNTL + V this cut out element(s) into the main image, flipping, rotating, resizing and warping as
appropriate. Name this layer “ear”.
Cut out some more piping from picture 041.jpg and assemble the cross beam of the ear. Place this layer
under the ear layer and merge the two ear layers.
Open picture 315.jpg and cut out an element suitable for ear’s insertion into head.
CNTL + V this cut out element and place it under the ear layer. As the element I have chosen does not look
very metallic, I apply an embossing filter to it: 113% and -126 degrees.
Merge the ear layers again and if the layers names have changed, ensure the layer is called “ear”

STEP 11 - More Mechanical Elements

Add some more bits of hose to increase the mechanical elements on the
head - eg neck tendons and brow furrows. Once the layers are merged
and named appropriately, delete the excess layers containing hoses.

STEP 12 - Minor Tweaks

Select the “base colours” layers. Erase the grey from under the rhs
forehead element that does not quite fit and paint in green on the “skin
tone” layer.
If anything else looks like it needs tweaking, spend a few minutes on this.
eg I noticed the lhs ear element needed some of the “base colours” layer
erased. I should note that much of the base colours are there to give me
an idea of overall colour values and probably will not contribute directly
to the final image.

STEP 13 - Skin Tone Preparation

Return to img_3805.jpg. Select an area with nice round scale, such as the
cheek of the lizard. Cut one of these out and copy/paste to form the pectoral of the main image. Name this
layer “chest plates” and place it above the “base colours” layer.
Open img_3815,jpg and select a good clear section of scales from the side of the lizard. Copy a large area
into the main image and move off to the right so it does not cover the underdrawing.
Using the clone tool, a soft brush and the opacity set to 70%, clone the scales in such a way that areas of
inconsistency and larger/smaller scales are softened.
Copy and paste this layer a few times so the height and width matches the main image. This has produced
some glaring lines at the junction of each copied section. After merging the scales into a single layer, use the
clone stamp tool to smooth these out.
Name this layer “scales”
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STEP 14 - Adding Scales to Skin

Drag the scales over the top of the main image and use the warp tool to fit the
scales to the image. Position this layer to the bottom.
Erase the excess scales using eraser set to 100% and a fuzzy brush.
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STEP 15 - Arranging And Adjusting Layers

Move the “chest plates” layer above the “scales” layer and set the layer option to “luminosity”. Use the eraser
tool to smooth out the darker lines on the chest plating.
Adjust the transparency of the “skin base” layer to 38%.
Change the “shadow” layer filter option to “linear burn”.
Change the “highlights” layer filter option to “multiply”
Right click on the existing “highlights” layer and select “duplicate” layer and merge with underlying highlights
layer.
Merge all mechanical layers that were created using the hoses.
Run embossing filter over the merged mechanical element’s layer to give the hoses a metallic look: Filter >
Stylise > Emboss) using the default settings.
Emboss the “nostrils layer” using -81 angle, height of 5 pixels and an amount of 60% and set this layer to
subtract.

STEP 16 - Overall Image Appraisal

Tweak some of the layers by improving the shadow and add some more depth to the image.
This only really worked with the shadowing. The image is looking a bit flat and washed out. Return to image
3805.jpg and copy some scales into the main picture again, positioning them off to the side.
Place this layer between “nostrils” and “base colours.

STEP 17 - Working On Skin Tone

Change the colour of the scales using the hue/saturation tool
set to colourise using the following settings: hue: 360, sat: 94,
lightness: -5.
Using the clone tool at 24% and a soft brush 24, build up the
face from the scales. One you are happy with this, click on the
eyes layer and run over the top lids with the cloned scales once
or twice.
Save the image as version a (just in case you are not happy with
anything that you do next).
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STEP 18 - Making The Elements Fit Better
Delete the “d 270”layer”.

Duplicate the “mechanical elements” layer and run a blur (eg Gaussian)
filter over the duplicated layer. Reduce the opacity a little to soften the
underlying layer.
Flatten the entire image and duplicate the layer once you unlock it
(double click on the layer name and unlock).
Select “colour burn” for the upper layer and erase everything but for
select regions of the eyes and the “real” ear in an attempt to give the
image some depth.
Merge the layers.
Flip the image horizontally to see if it looks well proportioned. This
does not.
Copy the layer and flip your image horizontally. Paste the copied image
into a new layer by pressing CNTL + V.
Erase some of the upper layer to reveal the underlying layer. This will make the image look more
proportioned.
Merge the two layers.

STEP 19 - Tweaking The Area

The last manipulation gave the image a larger bolder chin.
The image still looks quite flat and I feel it needs something
more. Open Aug09Cairns143.jpg.
Use the selection tool to chop out some spikes and
surrounding scales and copy into this into the main image.
Use the polygonal lasso tool to clean up the inserted image
and then warp tool the image so it fits into the chin area.
Copy the inserted chin image into a new layer and after
positioning it effectively, merge the layers and clean the
chin element up using the eraser tool.
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STEP 20 - Revisiting Skin Tone

As the chin effect seemed to work well and the skin looks a bit washed out, repeat what you did in step 18 to
build up the cheeks with some large scales. Do this also for the lips of the character.
Create a new 300dpi 2000x2000 image and copy a good scale section into it from one of the provided image
files.
Magic wand the background and apply a content aware fill. Copy this into the main image and scale to it to
fit the canvas.
Make sure the layer is under the newly added skin elements on the cheeks and chin.
Reduce the opacity of the new scales layer and remove everything overlapping the background.
Excluding the mechanical ear, the scales over the top of the mechanical elements look good - leave them.
Clear the eyeball scales from the eyeballs using the eraser or polygonal selection tool.
The image is starting to look ok. Flatten the image and unlock the layer then duplicate it several times.
Hide all but two layers.
Change the upper layer to linear dodge and erase areas which should be in shadow then merge down.
Make one of the hidden layers visible and set the opacity to 74% then merge down.
Make one of the hidden layers visible and Gaussian blur it. Set this layer to 50% opacity. The effect appears
unsatisfactory, discard this layer.
On a copy of the base layer, use the smudge tool to soften the jarring around the eyes and make them sit
better in the image.

STEP 21 - Giving The Image Depth.

Use the dodge and burn tool set to 20%. Burn will add shadow to the
image and dodge will lighten it.
Go over the image adding shadow and highlights. Do not over use this
too. Done correctly, the face will begin to pop out from the image and
some nice depth will develop
Erase around the edge of the main image element to clean up the edges.
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STEP 22. Add A Background

Magic wand the white background and cut it out. Clean up the
surrounds of the image as some white specs remain and the main image
has a sort of halo around it.
Add a layer at the bottom and fill it with random colour then Render >
Difference Clouds.
Use the hue/saturation effect to give the background some non-intrusive.
If the image is looking a little washed out and flat, have a play around
with the levels to see if you can bring up the colours a little.
Once you have done this, you can call it a day.

Additional Notes:

Steps 13, 14 and 17 could be removed as afterthought manipulations negate the effects created with these
steps. I have left them in as this tute was a personal an exercise in learning Photoshop as well as one where
you learn also.
With some additional tweaking, the nose and ear can be made to pop out from the image as they look a bit
flat in the final image.
Tutorial © Paul Yeatman 2012. All rights reserved.
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